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4 Создание 3D моделей 

Ñîçäàíèå áèáëèîòåêè 
3D ìîäåëåé è òðàíñëÿöèÿ
ñáîðêè ïëàòû èç Altium
Designer 6 â MCAD
ААллееккссеейй  ССааббуунниинн,,  ММоосскквваа      ssaabbuunniinn@@rrooddnniikk..rruu

ВВппооссллеедднниихх  ввееррссиияяхх  AAllttiiuumm  DDeessiiggnneerr  66  ззннааччииттееллььнноо  рраасс##
шшиирреенныы  ввооззммоожжннооссттии  ррааббооттыы  сс  MMCCAADD  ссииссттееммааммии..  ЭЭттии
ввооззммоожжннооссттии  ооттннооссяяттссяя  ккаакк  кк ггееннееррааццииии  ттррееххммееррнноойй

ммооддееллии  ппллааттыы  ннаа  ооссннооввее  ддаанннныыхх  ррееддааккттоорраа  ппллаатт,,  ттаакк  ии  кк ссоозз##
ддааннииюю  ссооббссттввеенннныыхх  ббииббллииооттеекк  ттррееххммееррнныыхх  ммооддееллеейй  ккооммппоо##
ннееннттоовв..  УУччииттыыввааяя  ттоотт  аассппеекктт,,  ччттоо  ввссее  ббооллььшшееее  ккооллииччеессттввоо
ррооссссииййссккиихх  ррааззррааббооттччииккоовв  ппооддххооддяятт  кк ппррооееккттииррооввааннииюю  ррааддии##
ооээллееккттрроонннныыхх  ууссттррооййссттвв  ккаакк  кк ссииссттееммннооммуу  ппррооццеессссуу,,  ддааннннааяя
ввооззммоожжннооссттьь  ссттааннооввииттссяя  ооссооббеенннноо  ааккттууааллььнноойй..  ИИммеенннноо  ээттаа
ппррооббллееммаа  ннааииббооллееее  ччаассттоо  ппооддннииммааееттссяя  ннаа  ссееммииннаарраахх,,  ппррооввоо##
ддииммыыхх  ууччееббнныымм  ццееннттрроомм  ЗЗААОО  ««ННПППП  ««РРООДДННИИКК»»,,  ии  ннааииббооллььшшееее
ккооллииччеессттввоо  ввооппррооссоовв  ппоо  ттееххннииччеессккоойй  ппооддддеерржжккее  ооттннооссииттссяя
ииммеенннноо  кк ээттоойй  ттееммааттииккее..  ВВ ддаанннноойй  ссттааттььее  ппррииввееддеенн  ппооссллееддоо##
ввааттееллььнныыйй  ((sstteepp##bbyy##sstteepp))  ааллггооррииттмм  ссооззддаанниияя  ббииббллииооттеекк  33DD
ммооддееллеейй  cc  ппррееддввааррииттееллььнныымм  ииммппооррттоомм  иихх  иизз  MMCCAADD,,  аа ттааккжжее
ппооссллееддууюющщееггоо  ссооххррааннеенниияя  ггооттооввоойй  ппллааттыы  вв оодднноомм  иизз  ффооррммаа##
ттоовв  ммееххааннииччеессккоойй  ССААППРР..

Начнем работу с создания библиоте!
ки символов, для чего, после запуска
Altium Designer, выполним File>New>
Library> Schematic Library и сохраним
созданную библиотеку в отдельную пап!
ку под названием AD_SW. Для работы
с открывшимся редактором использует!
ся панель SCH Library, если она не отк!
рылась автоматически, ее можно за!
пустить из вкладки SCH в нижнем ле!
вом углу рабочего окна программы. 

Запущенная панель имеет 4 окна, в кото!
рых будет представлена информация
о библиотеке, в первом указан перечень
компонентов (Components), далее анало!
гичные выбранному компоненты
(Aliases), выводы выбранного компонен!
та (Pins) и модели, подключенные к ком!
поненту (Model). По умолчанию библиоте!
ка уже имеет компонент с названием
Component_1. Выполняем двойной щел!
чок мыши на названии компонента в па!
нели SCH Library и в строке Symbol
Reference появившегося окна вводим
название компонента «Резистор». Закры!

ваем данное окно и создаем УГО резистора, командой Place
Pin устанавливаем 2 вывода и командой Place Line рисуем уп!
рощенное изображение. Сохраняем библиотеку с созданным
компонентом, выполнив команду File>Save. 

На данном этапе у нас имеется библиотека, в которой на!
ходится один компонент (!), а не символ, как это было в P!CAD.
В этом заключается принципиальное отличие структуры биб!
лиотек Altium Designer от библиотек P!CAD, где символ и ком!
понент были разными понятиями. Здесь символ уже представ!
ляет компонент, к которому могут быть подключены несколько
моделей, например, модель топологического посадочного
места, трехмерная модель, модель для анализа целостности
сигнала и Spice!модель. В рамках данной статьи рассмотрим
создание, подключение и согласование первых двух моделей. 

Прежде чем подключить модель топологического посадоч!
ного места, ее необходимо разработать, для чего нужно соз!
дать библиотеку посадочных мест: File>New>Library>PCB
Library. Сохраним созданную библиотеку под названием
AD_SW, при этом она будет иметь расширение, отличное от ра!
нее созданной одноименной библиотеки символов. Это еще
одно отличие структуры библиотек Altium Designer, здесь раз!
нотипные библиотечные элементы хранятся в разных библио!
теках. В P!CAD все элементы (компоненты, символы и модели
посадочных мест) хранились в одной библиотеке с расширени!
ем *.lib. Создадим модель резистора: командой Place Pad –
разместим контактные площадки и Place Line – нарисуем кон!

Рис. 1. Свойства контактной площадки
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тур резистора для шелкографии в слое Top Overlay. При этом на
этапе создания модели топологического посадочного места
следует обратить внимание на расположение точки привязки,
на рисунке 1 она совпадает с положением левой контактной
площадки. Точка привязки не всегда отображается «по умол!
чанию», для ее отображения следует включить соответствую!
щую опцию Origin Maker, в Altium Designer 6.8 она находится на
вкладке View Options окна Tools>Layers&Colors (клавиша L).
Свойства контактной площадки задаются в окне Pad, вызыва!
емом нажатием клавиши TAB при размещении или двойным
щелчком мыши на уже размещенной площадке. На данном
этапе необходимо указать параметры отверстия в разделе
Hole Information, форму контактной площадки в разделе Size
and Shape и тип контактной площадки (SMD или монтаж в от!
верстия) в строке Layer (Multi!Layer – определяет контактную
площадку с отверстием). После создания контактной площад!
ки резистора сохраним ее под соответствующим именем, для
чего в панели PCB Library (которая вызывается аналогично
SCH Library) выполним двойной щелчок мыши на названии
компонента и в строке Name введем название «Резистор».

Теперь в панели Project (рис.1) мы имеем 2 библиотеки, ко!
торые пока расположены в папке Free Documents, что говорит
о непринадлежности данных библиотек к какому!либо проек!
ту. Для создания схемы и платы нам достаточно двух создан!
ных библиотек, но для последующей передачи проекта платы в
MCAD, нужно иметь библиотеку трехмерных моделей компо!
нентов. Прежде чем создавать данную библиотеку, необходи!
мо в используемой MCAD создать модель и сохранить ее
в формате IGES или STEP.

При создании трехмерной модели в MCAD следует обра!
тить внимание на расположение точки привязки, желательно

ее совместить с одним из выводов резистора. Модель дан!
ного резистора была сохранена в формате IGES под назва!
нием «res».

Возвращаемся в Altium Designer и создаем библиотеку
трехмерных моделей: File>New>Library>PCB3D Library. Для
создания новой модели воспользуемся возможностью импор!
та готовой модели в формате IGES, ранее созданной в MCAD,
для этого выполним: Tools>Import 3D Models и укажем распо!
ложение модели резистора в формате IGES. После этого в ра!
бочей области появится изображение резистора. Для работы
с моделью используется панель PCB3D Lib, которая включает!
ся по вкладке в нижнем левом углу. В этой панели показаны
модели, содержащиеся в библиотеке (в данном случае одна
модель res), и дополнительные опции, из которых включить
нужно одну – Show Axis (Показать координатные оси).

Сохраняем созданную библиотеку под названием AD_SW и
возвращаемся на первый этап работы, где создавался сим!
вол. Теперь наша задача: подключить созданные модели
к компоненту, но прежде чем к этому приступить рекомендует!
ся создать интегрированную библиотеку и объединить в ней
все ранее созданные библиотеки. Интегрированная библио!
тека позволит проще создать ссылки на модели компонента и,
в дальнейшем, даст существенные преимущества при хране!
нии и использовании библиотек. Интегрированная библиоте!
ка создается командой: File>New>Project>Integrated Library.
Появившуюся в панели Project библиотеку сохраняем под наз!
ванием AD_SW и перемещаем ранее созданные библиотеки
в интегрированную (для чего перетаскиваем ярлыки библио!
тек в структуре Project, аналогично перетаскиванию в провод!
нике Windows).

Рис. 2. Создание модели в MCAD и сохранение ее в формате IGES или STEP
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После того, как была создана интегрированная библиоте!
ка и в нее добавлены файлы, нажимаем кнопку Add Footprint,
и, в появившемся окне, кнопку Browse… При этом сразу будет
предложено выбрать модель для компонента из нужной биб!
лиотеки, т.е. предлагается библиотека, входящая в структуру
интегрированной библиотеки. Здесь выбираем единственный
файл модели и закрываем все окна последовательным нажа!
тием кнопки ОК в каждом из них. При добавлении трехмерной
модели нужно в окне PCB3D Model Libraries выбрать вариант
Library Path и указать модель вручную, как показано на рисун!
ке 4. После указанных действий наш компонент имеет 2 моде!
ли, которые показаны в списке Model панели SCH Library.

Чтобы посмотреть, как будет выглядеть разработанная мо!
дель на плате, и отладить ее в случае необходимости, созда!
дим небольшую схему, по которой будет сгенерирована плата
и трехмерная сборка платы. Прежде чем создавать схему сто!
ит откомпилировать интегрированную библиотеку, т.к. на эта!
пе ее формирования она имеет расширение LibPkg и в таком
виде не может быть добавлена в список библиотек Libraries и,
соответственно, не может быть использована.

После разработки платы и трассировки, для получения
трехмерной сборки, выполняем View>Legacy 3D View, находясь
в редакторе плат.

При просмотре 3D видно, что резисторы ориентированы
некорректно по отношению к плате (рис. 6). Есть два пути для
исправления этой несогласованности, во!первых, вернуться

Рис. 3. Подключение модели к компоненту

Рис. 4. Выбор трехмерной модели
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Рис. 6. Просмотр объемного вида платы в Altium Designer

Рис. 5. Разработка схемы и платы
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в пакет, где изначально была создана модель и исправить там
ее ориентацию относительно базовых осей. При этом придет!
ся потом опять подключать модель, к тому же эту операцию
может потребоваться сделать неоднократно, чтобы точно по!
зиционировать элемент на плате. Поэтому для согласования
3D модели и посадочного места можно воспользоваться сред!
ствами Altium Designer. Для этого открываем библиотеку
AD_SW.PCB3DLib и выполняем Tools>Set Rotation and
Translation, в появившемся окне можно подкорректировать
положение элемента относительно базовых осей. В нашем
случае необходимо повернуть модель резистора по оси X на
90 градусов. После этого необходимо пересохранить библио!
теку моделей и из редактора плат повторно выполнить
View>Legacy 3D View. Теперь резисторы расположены на пла!
те, как это было предусмотрено конструктором.

Находясь в режиме просмотра трехмерного вида платы,
выполняем команду Tools>Export, после чего в появившемся
окне (рис. 7) выбираем набор объектов для импорта и ограни!
чение по высоте импортируемых компонентов. В результате
последних операций в указанной папке будет сгенерирован
файл IGES, который теперь можно открыть в MCAD и использо!
вать для разработки электронного блока с возможностью про!
верки сопряжений с крепежными деталями. Форматы IGES и
STEP относятся к форматам MCAD, то есть они не обладают
возможностью двустороннего импорта. Плата, сохраненная

в одном из этих форматов, не может быть обратно конверти!
рована в Altium Designer. Если возникает необходимость
в двусторонней трансляции, то нужно использовать файл IDF,
который может быть получен выполнением команды File>Save
As из редактора плат. При этом стоит отметить, что при исполь!
зовании данного формата передается не вся информация,
например геометрия компонентов передается условно в виде
контура, вытянутого на высоту компонента указанную в его
свойствам… ■■

Рис. 7. Формирование файла трехмерной сборки для MCAD в формате IGES
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Îò P-CAD 
ê Altium Designer 6
(ïðîäîëæåíèå)
ВВллааддииммиирр  ППррааннооввиичч,,  ККииеевв      pprraannoovviicchh@@bbssuu..bbyy  

ССттааттььяя  ппооссввяящщееннаа  ввооппррооссаамм  ссооггллаассоовваанниияя  ддооккууммееннттоовв
ииммппооррттииррооввааннннооггоо  ппррооееккттаа  ((ссххееммаа,,  ттооппооллооггиияя,,  ббииббллииоо##
ттееккии))  ннаа  ппррииммееррее,,  ппррииввееддеенннноомм  вв  ппууббллииккааццииии  ««ООтт  PP##

CCAADD  кк  AAllttiiuumm  DDeessiiggnneerr»»  ((EEDDAA  EEsspprreessss,,  №№1155)),,  ггддее  ммыы  ооссттааннооввии##
ллииссьь  ннаа  ддооссттиижжееннииии  ссооооттввееттссттввиияя  ттооллььккоо  ээллееккттррииччеессккиихх  ссввяя##
ззеейй  ннаа  ссххееммее  ии  вв  ттооппооллооггииии..  ММыы  ппррооддооллжжиимм  ррааббооттуу  сс  ээттиимм
ппррииммеерроомм  ии  ппррееддссттааввиимм  еещщее  рряядд  ннююааннссоовв,,  ввооззннииккааюющщиихх  вв
ппррооццеессссее  ааддааппттааццииии  ппррооееккттоовв,,  ииммппооррттиирроовваанннныыхх  иизз  ппааккееттаа
ппррооееккттиирроовваанниияя  PP##CCAADD..

Подготовка проекта
В качестве примера в этой статье воспользуемся прежним

проектом «pd!v2!1», который можно скачать с сайта www.rod!
nik.ru на вкладке ООббууччееннииее>>ППррииммееррыы::  ООтт  PP!!CCAADD  кк  AAllttiiuumm
DDeessiiggnneerr  66..00. 

Однако здесь оформим отдельный проект, для чего произ!
ведем следующие операции (рис. 1):

1. Создаем новую папку: ……//ppdd!!vv22!!22//. 
2. Копируем в нее все файлы ppdd!!vv22!!11..** из прежнего проек!

та и переименовываем их в ppdd!!vv22!!22..**.
3. Открываем файл EEDDAA__EExxppeerrtt..DDssnnWWrrkk  (база проектов из

прошлого примера). Примечание. Данный пункт можно
пропустить.

4. Добавим файл ppdd!!vv22!!22..PPCCBBPPRRJJ к базе EEDDAA__EExxppeerrtt..DDssnnWWrrkk
открытием его через меню FFiillee//  OOppeenn или с помощью
проводника Windows. Однако содержимое проекта ока!
жется пустым, так как в нем прописаны ссылки на файлы
прежнего проекта ppdd!!vv22!!11..** (которые мы переименовали
ранее). 

5. Командой AAdddd  EExxiissttiinngg  ttoo  PPrroojjeecctt добавляем к проекту
все файлы из новой папки ……//ppdd!!vv22!!22//. 

6. Вид панели PPrroojjeecctt  после указанных операций представ!
лен на рисунке.

Проверка проекта
После наполнения нового проекта файлами следует обяза!

тельно проверить их на соответствие схемы и топологии. Для
этого при открытой схеме:

1. Командой DDeessiiggnn//  UUppddaattee  DDeessiiggnn  DDooccuummeenntt  ppdd!!vv22!!22..PPCCBB!!
DDOOCC вызываем окно EEnnggiinneeeerriinngg  CChhaannggee  OOrrddeerr.

2. Нажимаем кнопку VVaalliiddaattee  CChhaannggeess для проверки воз!
можности ввода изменений в файл топологии. Те из них, кото!
рые невозможно произвести, будут помечены крестиком в
столбце SSttaattuuss  CChheecckk.

a) во!первых, это список CChhaannggee  CCoommppoonneenntt  FFoooottpprriinntt. По!
явление его связано с тем, что названия FFoooottpprriinntt в схе!
ме и файле топологии не только не совпадают, но, более
того, по названию FFoooottpprriinntt  из схемы не найдено ни од!
ного с таким же названием ни в одной из подключенных
библиотек. Способы устранения такого рода ошибок
рассмотрим ниже;

b) во!вторых, это список AAdddd  PPiinn  ttoo  NNeettss. Связан он с тем,
что в DDeessiiggnnaattoorr  PPIINN (номер вывода) для схемного эле!
мента и его DDeessiiggnnaattoorr  PPAADD (номер ножки) посадочного
места не совпадают. При импорте такое несоответствие
возникло для компонентов, которые имели несколько
FFoooottpprriinntt в пакете проектирования P!CAD. В частности,
несоответствия PPiinn  11 для конденсаторов CC11 и СС33 на ри!
сунке отмечено в желтом прямоугольнике. 

Удаление несоответствия списка 
«Add Pin to Nets»
Для устранения ошибок типа AAdddd  PPiinn  ttoo  NNeettss есть два варианта.

Первый – это изменение компонента на схеме и редакти!
рование PPiinn  MMaapp (карты связи). При этом способе необходимо
сделать следующее (рис. 3):

1. Открываем файл топологии и выделяем там конденсатор
CC11. При таком способе выделения все элементы топологии пе!
чатной платы, кроме данного компонента, будут замаскированы.

2. Увеличим окно просмотра, выделим PPAADD данного компо!
нента и найдем значения для DDeessiiggnnaattoorr  PPAADD. Они имеют вели!
чину соответственно «1» и «+».

3. Нажимаем кнопку CCrroossss  PPrroobbee, при этом указатель превра!
тится в перекрестие, и отмечаем им наше посадочное место CC11.

4. Переходим на вкладку схемы. Наш конденсатор будет
выделен, остальная часть схемы замаскирована.

Рис. 1. Добавление файлов к проекту 
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Рис. 3. Редактирование MAP 

Рис. 2. Проверка соответсвия схемы файла топологии 
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5. Двойным щелчком по конденсатору CC11 открываем его
свойства, а затем кнопку EEddiitt на окне MMooddeell.

6. В окне PPCCBB  mmooddeellss нажимаем кнопку PPiinn  MMaapp.

7. В окне MMooddeell  MMaapp находим несоответствие нумерации
(DDeessiiggnnaattoorr  PPIINN==  ««++»»,,  DDeessiiggnnaattoorr  PPAADD==  ««11»»). Изменяем отмечен!
ный DDeessiiggnnaattoorr  PPAADD со значения «1» на «+».

На этом процесс коррекции для компонента CC11 завершен,
и при следующей проверке ошибка, связанная с данным кон!
денсатором, исчезнет. Большинство ошибок в проекте связа!
но с данным посадочным местом. Предложенное исправление
не совсем удобно. Следует для единообразия переименовать и
второй PPaadd со значения «2» на значение «–». А для этого при!
дется исправлять его и в имени вывода, и в контактной пло!
щадке посадочного места в файле топологии.

Рис. 4. Групповое изменение Designator PAD посадочного места

1

2

5

3

3

3

3

3

4

4

4



12 От P�CAD к Altium Designer 6

Поэтому обратимся ко второму варианту и исправим обоз!
начение PPaadd только в посадочном месте (со значения «+» на
значение «1»). Итак, в этом случае делаем практически то же
самое, но в обратном порядке:

1. Открываем схему.

2. Выделяем конденсатор CC11.

3. Определяем значения DDeessiiggnnaattoorr  PPAADD, они соответствен!
но имеют величину «1» и «2», то есть названы единообразно.

4. Нажимаем кнопку CCrroossss  PPrroobbee и указываем на наше по!
садочное место CC11.

5. Переходим на вкладку файла топологии. Наш конденса!
тор будет выделен, остальная часть схемы замаскирована.

6. Двойным щелчком по PPAADD со значением DDeessiiggnnaattoorr==  ««++»»
конденсатора CC11 открываем свойства его PPIINN.

7. Изменяем значение DDeessiiggnnaattoorr  PPIINN= с «+» на «1».

Вышеперечисленные операции осуществим для всех ком!
понентов, для которых было найдено несоответствие. Как было
отмечено выше, это несколько групп однотипных компонентов. 

В данном примере автор реализовал все изменения по
первому варианту для соединителя и по второму варианту для
остальных компонентов. При этом в файле топологии произ!
вести эту процедуру можно значительно проще и, более того,

сразу для группы компонентов. В этом случае поступим таким
образом (рис. 4): 

1. Открываем PPCCBB. Выделяем конденсатор CC11. 

2. Снимаем выделение и, зная, что данное несоответствие
должно быть у всех идентичных посадочных мест, при наведе!
нии указателя на PPaadd с обозначением DDeessiiggnnaattoorr==  ««++»» (а лучше
вообще этот PPaadd выделить) конденсатора CC11 нажатием правой
кнопки мышки вызываем контекстное меню FFiinndd  SSiimmiillaarr  OObbjjeecctt.

3. В окне FFiinndd  SSiimmiillaarr  OObbjjeecctt укажем поиск по всем подоб!
ным PPaadd  ««++»» конденсатора СС11, для чего устанавливаем следу!
ющие параметры поиска:

• OObbjjeecctt  KKiinndd  ==  PPaadd,,  SSaammee – поиск по всем PPaadd;
• HHoollee  SSiizzee  ==  00mmmm,,  SSaammee – площадка без отверстия;
• PPaadd  SShhaappee  ==  RRoouunndd  RReeссttааnnссее,,  SSaammee – форма площадки –

прямоугольник со скругленными углами;
• PPaadd  XX  SSiizzee  ==  22..55mmmm,,  SSaammee – горизонтальный размер 

площадки;

• PPaadd  YY  SSiizzee  ==  22..55mmmm,,  SSaammee – вертикальный размер 
площадки;

• Остальные параметры – поиск по ним не ограничивается.

4. При выполнении операции в нашем примере выделится
7 PPaadd. 

5. Нажатием клавиши FF1111 вызываем панель Inspector,
убеждаемся, что таких элементов 7, а это соответствует ошиб!
кам данного рода, и правим одновременно для всех выделен!
ных PPaadd  DDeessiiggnnaattoorr= значения «+» на «1».

6. Аналогично поступаем с конденсаторами CC1188 и CC3300, а
также с соединителем XX66.

7. Командой DDeessiiggnn//  UUppddaattee  DDeessiiggnn  DDooccuummeenntt  ppdd!!vv22!!22..PPCCBB!!
DDOOC только проверяем, но не передаем изменения, необходи!
мые для ввода из схемы в файл топологии. Обратите внима!
ние. Эта операцию приведена для примера, чтобы вы убеди!
лись в правильности действий. В таблице EECCOO!генератора при!
сутствуют только сообщения, связанные со списком CChhaannggee
CCoommppoonneenntt  FFoooottpprriinntt. Переходим на вкладку файла топологии
и командой DDeessiiggnn//  UUppddaattee  SScchheemmaattiicc  iinn  ppdd!!vv22!!22..PPRRJJPPCCBB вво!
дим изменения в схему.

Итак, мы добились полного соответствия между выводами
компонентов на схеме и контактными площадками посадоч!
ных мест в файле топологии, за исключением механических
элементов печатной платы (держатели батарей и место для ус!
тановки внешнего тумблера), которые не имеют аналогов в
схеме. Однако на решении этого вопроса остановимся немно!
го позже.

Рис. 5. Создание библиотеки посадочных мест 

Рис. 6. Групповое изменение названий посадочных мест 

2 2

1

ab

c

d



13От P�CAD к Altium Designer 6

Формирование библио�
тек проекта 
После достижения полного соответ!

ствия выводов компонентов их контакт!
ным площадкам в посадочном месте
можно сформировать и библиотеки
проекта. Начнем с библиотеки посадоч!
ных мест. Для того чтобы ее создать и
успешно сохранить, выполним следую!
щие операции (рис. 5):

1. Командой MMaakkee  PPCCBB  LLiibbrraarryy при
открытом файле топологии проекта
формируем библиотеку посадочных
мест. Библиотека сформируется, одна!
ко после ее сохранения и нового откры!
тия она не будет содержать ни одного
компонента. Причина этого – в исполь!
зовании в названиях посадочных мест
спецзнаков, в частности «''» (двойной
апостроф), который в Altium Designer 6
используется для других целей. Такие
проблемы легче было решить непосред!
ственно в P!CAD перед трансляцией
проекта. Однако, так вы будете действо!
вать в будущем. А сейчас на примере
решения этой проблемы продемонстри!
руем ряд способов и приемов, которые
вам пригодятся и в дальнейшей работе. 

2. Перед сохранением библиотеки
заменим в названиях посадочных мест
апостроф на другой символ, например,
на точку. Сохраним библиотеку и доба!
вим ее к проекту.

3. Однако, теперь названия посадоч!
ных мест файла топологии не будут соот!
ветствовать их аналогам в файле библи!
отеки. Это противоричие следует устра!
нить. Перейдем на вкладку файла топо!
логии и сделаем следующее (рис. 6):

a) вызовем панель PPCCBB  LLiisstt; 
b) в панели установим параметры:
• EEddiitt  – разрешение редактирова!

ния;
• AAllll  oobbjjeecctt – для всех объектов;
• CCoommppoonneenntt – принадлежащих этому типу.
c) отсортируем таблицу по колонке FFoooottpprriinntt и выделим в

ней строки с одинаковым названием, например,
00880055__HH11''33LL33''22__WW88HH11''55;

d) вызовем контекстным меню (правый клик) EEddiitt  и изме!
ним название 00880055__HH11''33LL33''22__WW88HH11''55 посадочного
места на 00880055__HH11..33LL33..22__WW88HH11..55;

e) аналогично поступим и с другими названиями, которые
следует изменить.

4. Командой DDeessiiggnn//  UUppddaattee  SScchheemmaattiicc  iinn  ppdd!!vv22!!22..PPRRJJPPCCBB
вводим изменения в схему.

5. Наконец, переходим на вкладку схемы и командой
DDeessiiggnn//  MMaakkee  SScchheemmaattiicc  LLiibbrraarryy формируем библиотеку с ком!
понентами для схемы.

Теперь вернемся к проблеме механических элементов, по!
садочные места которых расположены на печатной плате, од!
нако они не имеют компонентов на схеме.

Ввод в схему компонентов 
для механических деталей
В данном примере введем в схему ссылки на механические

компоненты, так как здесь это наиболее удобно. Хотя предло!
женный вариант – только один из существующих подходов к ре!
шению этой проблемы. Итак, совершим следующие операции:

Рис. 7. Добавление и редактирование свойств компонента в библиотеке 

1 •Держатель батарей
G-BH_BH-603_2AA

Рис. 8. Графическое изображение компонента 
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1. Откроем библиотеку ppdd!!VV22!!22..SSCCHHLLIIBB, только что создан!
ную нами.

2. Откроем панель SSCCHHLLiibbrraarryy.

3. Добавим нажатием кнопки AADDDD новый компонент и
присвоим ему имя, например, GG!!BBHH__BBHH!!660033__22AAAA (такое наз!
вание имеет посадочное место).

4. Выделим данный компонент в строке и нажмем кнопку
Edit для редактирования свойств нового компонента.

5. В окне свойств компонента (LLiibbrraarryy  CCoommppoonneenntt  PPrrooppeerrttyy):

a) установим тип (SSttaannddaarrdd) нового компонента;
b) присвоим значение DDeessiiggnnaattoorr  по умолчанию, напри!

мер, MMeecchh??. Вопросительный знак в конце означает, что
при автонумерации в схеме он автоматически изменит
свое значение в соответствии с принципом нумерации;

c) при необходимости можем изменить имя компонента;
d) параметры компонента можно и не вводить на данном

этапе, но мы добавим один: NNoottee со значением ««ДДеерржжаа!!
ттеелльь  ббааттаарреейй»». Для этого нужно нажать кнопку AADDDD и

ввести имя параметра и его значение. После этого пара!
метр и его значение будут перенесены в соответствую!
щую строку;

e) присвоим нашему компоненту ссылку на посадочное
место. Для этого нужно нажать кнопку AADDDD, выбрать тип
подключенной модели (FFoooottpprriinntt) и указать нужное поса!
дочное место, найдя его в библиотеке, в нашем случае
GG!!BBHH__BBHH!!660033__22AAAA).

6. Теперь перейдем на окно изображения графики и созда!
дим изображение механического компонента, как показано
на рис. 8, где отмечено: 

a) положение и значение параметра DDeessiiggnnaattoorr;
b) положение и значение параметра CCoommmmeenntt;
c) положение и значение параметра NNoottee.

7. Аналогично можно поступить и с другими механическими
элементами. Однако их можно и не создавать, а воспользо!
ваться прежними. Так мы и сделаем. Только на схеме придется
изменить значения параметров и ссылки на посадочное место.

8. Нажатием кнопки PPllaaccee добавим на схему указанный
компонент, разместив его в удобной зоне.

Рис. 9. Вид схемы 
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9. Присвоим новым компонентам на схеме значения
DDeessiiggnnaattoorr, соответствующие импортированным на печатной
плате, и изменим значения параметра NNOOTTEE для удобства чте!
ния схемы.

10. Включаем в EECCOO!генераторе все опции и опять совер!
шаем операцию UUppddaattee схемы из файла топологии для присво!
ения механическим компонентам схемы соответствующих по!
садочных мест. Теперь схема и файл топологии полностью со!
ответствуют друг другу.

На этом процесс связи схемы и файла топологии проекта,
а также их библиотек, завершен. Однако, если к импортиро!
ванному дизайну печатной платы претензий как таковых нет,
то схема выглядит совсем непрезентабельно, хотя с точки зре!
ния электрических связей в ней все верно.

Подключения к листу схемы шаблона
Итак, приведем схему без существенных переделок к более

удобочитаемому виду. Начнем с подключения шаблона рамки.

Схема в исходном пакете проектирования P!CAD размеща!
лась на листе формата A3. Однако, при импорте она была подг!
ружена на один из стандартных листов формата A2, поскольку
на лист такого размера поместилось изображение импортиро!
ванной схемы. Если у вас есть исходный файл шаблона, вы его
можете независимо импортировать в Altium Designer 6 и подг!
рузить к данному проекту. Мы этого делать не будем, так как
вопрос импорта шаблона не представляет интереса. Можно заг!
рузить один из шаблонов (Template) самого пакета, но в этом
примере мы подключим шаблон, разработанный автором. 

Для подключения шаблона произведем следующие
действия (рис. 9):

1. Из схемного редактора командой DDeessiiggnn//  TTeemmppllaattee//  SSeett
TTeemmppllaattee  FFiillee  NNaammee подгружаем файл шаблона AA33HH11mmmm22000077.
Скачать данный файл можно с сайта wwwwww..rrooddnniikk..rruu вкладка

ООббууччееннииее>>  ППррииммееррыы::  ООтт
PP!!CCAADD  кк  AAllttiiuumm  DDeessiiggnneerr
66..00. В параметрах загруз!
ки указываем AAdddd  nneeww
ppaarraammeetteerr  tthhaatt  eexxiisstt  iinn
tteemmppllaattee  oonnllyy для добав!
ления параметров шабло!
на к листу нашей схемы.

2. Однако, поле разме!
щения схемы и рамки
шаблона не совмещены.
Это понятно. Точка при!
вязки импортированного
файла не совпадает с ле!
вым нижним углом шабло!
на. Поэтому сделаем так:

• Командой EEddiitt//  SSeelleecctt//AAllll  выделим все элементы
схемы (учтите: как и в P!CAD, элементы шаблона не
выделяются);

• Наведя указатель на один из элементов схемы, при
нажатой левой кнопке, перетянем изображение
всей схемы так, чтобы оно находилось внутри нового
шаблона;

• Отдельные элементы, частично выходящие за пределы
шаблона, выделяем индивидуально (как правило, это
только текст) и корректируем их положение.

3. Теперь внесем значения параметров для заполнения
стандартных записей в шаблоне. Для этого командой DDeessiiggnn//
DDooccuummeenntt  OOppttiioonn вкладка PPaarraammeetteerr открываем окно задания
значений параметров листа. Эти параметры аналогичны атри!
бутам листа для схемы в пакете проектирования P!CAD. Пара!
метры принадлежат только данному листу схемы. 

4. Вводим текст надписей, имеющихся в старой рамке им!
портированного проекта, в значения параметров листа, в на!
шем случае это:

• RR11GG11NNaammeePPrroodduucctt__DDooccuummeenntt11 => ULTRASONIX!PP!01;
• RR11GG11NNaammeePPrroodduucctt__DDooccuummeenntt22 => Регистратор аналого!

вых сигналов;
• RR22__11GG22GG2266DDeessiiggnnaattiioonnDDooccuummeenntt => УК!

МА.408744.017Э3;
• Остальные поля заполняются аналогично, неиспользуе!

мым присваивается значение «пробел».

5. Удаляем из схемы линии и текст, принадлежащие старой
рамке, которые остались на схеме при импорте.

ППррииммееччааннииее.. Автор и в рамке, и далее использует специ!
альные шрифты, удовлетворяющие требованиям ГОСТ. 

Теперь внешне схема выглядит так, как показано на рис. 9.
Однако более тщательное рассмотрение показывает необхо!
димость доработки непосредственно компонентов схемы.

Поворот текстовых надписей на схеме 
При импорте схемы положение надписей, относящееся к

компонентам, изменилось и многие из них имеют неверную
ориентацию. В настройках Altium Designer 6 есть флаг установ!
ки прочтения текста слева направо. Однако при применении
такой настройки возникает проблема с поворотом надписей

Рис. 10. Поворот текстовых надписей на схеме

1

4

2
3
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на 180 градусов. Поэтому этот флаг устанавливаем так, чтобы
текст на схеме мог принимать все четыре направления. Итак,
для восстановления правильной ориентации текста на схеме
импортированного проекта начнем с надписей, повернутых на
180 градусов, и поступим следующим образом (рис. 10):

1. Находим одну из надписей, ориентированную подобным
образом, например, надпись СС44 (DDeessiiggnnaattoorr – позиционное
обозначение компонента). 

2. Выделяем ее и вызываем панель FFiinndd  ssiimmiillaarr  oobbjjeecctt, как
делали ранее. В данной панели указываем поиск элементов в
схеме по параметрам:

• DDeessiiggnnaattoorr  ==  SSaammee – поиск по условным обозначениям
компонентов;

• OOrriieennttaattiioonn  ==  118800  DDeeggrreeeess  – направление текста – 180
градусов;

3. Вызываем инспектор и указываем правильное положе!
ние текста.

4. Получаем требуемый результат. 

Аналогично поступаем с текстом, повернутым на 270 гра!
дусов. Таким же способом поступим и с метками NNeettLLaabbeell –
для данной схемы это полный прототип PPoorrtt из пакета проекти!
рования P!CAD. Более того, здесь же вы одновременно сможе!
те устанавливать единый тип и размер шрифта для надписей
одного типа.

После глобального изменения направления отображения
всех параметров и установки их размера, вследствие того, что
размер надписей может немного отличаться от изображения в
исходном файле, рекомендую просмотреть всю схему и рас!
ставить надписи, исключив перекрытие ими других элементов
схемы. Более того, при просмотре схемы в данном примере
следует заменить все PPOORRTT, введенные при трансляции на
NNeettLLaabbeell, и убрать все неподключенные линии электрических
связей после такой замены.

Изменение положения имени выводов
компонентов 
Однако есть еще одна проблема. На рис. 11 представлен

компонент DD11, указана и его внутренняя структура. При этом
названия PPiinn оказались наложенными на изображение, что
затрудняет их прочтение. К сожалению, в AAllttiiuumm  DDeessiiggnneerr  66
нельзя индивидуально регулировать месторасположение наз!
вания PPIINN относительно положения отображения вывода.
Можно, конечно, просто отключить отображение названий
PPIINN. Однако это не решает проблему в принципе. Здесь можно
поступить следующим образом:

1. Найдем данный компонент на схеме и откроем свойства
компонента.

2. Нажмем кнопку EEddiitt  PPiinn и откроем окно редактирования.
3. Снимем флаг отображения NNaammee.
4. Двойным кликом по первой строке откроем окно редак!

тирования первого PPiinn  ((IIlliimm)), затем вкладку PPaarraammeetteerr. 
5. Добавим новый параметр, например, VViissiibbllee  NNaammee со зна!

чением IIlliimm и настроим остальные свойства параметра.
6. Произведем эту операцию для всех PPiinn, затем вернемся

в схему и поставим отображение новых параметров на
нужное место. 

Итак, схема завершена, и ее вполне можно отправлять в
архив. Возможно, она не совсем удовлетворяет нашим запро!
сам, однако не только полностью тождественна исходной, но
и, самое главное, полностью согласована с файлом топологии.
Единственное замечание: так как мы внесли много изменений
в схему при редактировании компонентов, схемную библиоте!
ку из проекта лучше создать на последнем этапе, тогда все из!
менения будут введены сразу в библиотечные компоненты. ■■

Рис. 11. Изменение положения имени выводов 
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Âàðèàíòû îòîáðàæåíèÿ
ìíîãîâûâîäíûõ ÈÌÑ 
â ïðîåêòàõ P-CAD 200*
ССееррггеейй ССеевваассттььяянноовв,,  УУллььяяннооввсскк      iinnffoo@@rrooddnniikk..rruu  

ППррии  ррааззррааббооттккее  ээллееккттрроонннныыхх  ууссттррооййссттвв,,  ссооддеерржжаащщиихх
ммннооггооввыыввоодднныыее  ээллееммееннттыы,,  ччаассттоо  ввооззннииккааеетт  ппррооббллееммаа
сс ооффооррммллееннииеемм  иихх  ппррииннццииппииааллььнныыхх  ссххеемм..  ССввяяззаанноо  ээттоо

сс ттеемм,,  ччттоо  ууссллооввнныыее  ггррааффииччеессккииее  ииззооббрраажжеенниияя  ((УУГГОО))  ттааккиихх
ээллееммееннттоовв  ппррии  ссооббллююддееннииии  ттррееббоовваанниийй  ЕЕССККДД  ддооввооллььнноо  ггрроо##
ммооззддккии,,  ччттоо  ввыыннуужжддааеетт  ллииббоо  ннееооббоосснноовваанннноо  ииссппооллььззооввааттьь
ббооллььшшииее  ффооррммааттыы,,  ллииббоо  ррааззддеелляяттьь  УУГГОО  ээллееммееннттоовв  ннаа  ббллооккии,,
ссооддеерржжаащщииее  ттооллььккоо  ииссппооллььззууееммыыее  вв ддаанннноойй  ссххееммее  ввыыввооддыы..
ИИ ттоо  ии  ддррууггооее  вв ииттооггее  ззааттрруудднняяеетт  ччттееннииее  ппррииннццииппииааллььнноойй  ссххее##
ммыы..  ККррооммее  ттооггоо,,  ррааззддееллёённнныыее  ннаа  ббллооккии  ббииббллииооттееччнныыее  ккооммппоо##
ннееннттыы  PP##CCAADD  ззааттрруудднняяюютт  ии  ссааммоо  ппррооееккттииррооввааннииее  вв ээттоойй  ссррее##
ддее  иизз##ззаа  ооттссууттссттввиияя  ееддииннооггоо  ууннииввееррссааллььннооггоо  ккооммппооннееннттаа..

Один из способов разрешения этой проблемы – это использо!
вание библиотечных компонентов с усечёнными УГО. Способ осно!
ван на допуске ЕСКД об использовании однолинейного обозначе!
ния электрических связей, имеющих общее функциональное наз!
начение (Рис.1) в совокупности со свойством Pin!контакта «Elec
Type» = Power (Library Executive / Pins View) среды P!CAD 200*, нес!
ти информацию о номере (названии) электрической цепи.

К упомянутому типу связей можно отнести, например, адрес!
ные шины и шины данных ИМС памяти, порты микропроцессо!
ров, входы многоразрядных или матричных индикаторов, ЦАП,
АЦП и многие другие. Все эти цепи в некоторых случаях можно
на стадии разработки принципиальной схемы и печатной платы
приравнять по функциональному назначению (в рамках библи!
отечного компонента) к цепям питания, которые при использо!
вании свойства «Elec Type» = Power на УГО не указываются. Это,
конечно, является ошибкой и если использовать усечённый
компонент на стадии моделирования принципиальной схемы,
такая искусственно созданная ошибка обязательно себя проя!
вит, о чём забывать не следует. В остальных же случаях достои!
нства очевидны, т.к. уменьшение габаритов УГО таким спосо!
бом никак не отражается на трассировке платы.

Рассмотрим это на примере узла 24!разрядного блока па!
мяти, выполненного на базе многовыводной микросхемы
FLASH!памяти AM29F010, имеющей 17!разрядную шину адре!
са и 8!разрядную шину данных. Исполнение УГО библиотечно!
го компонента с учётом вышеизложенного могут быть трёх ос!
новных типов (Рис.2): классическое, усечённое по адресной
шине (Вариант «А») и усечённое по обеим шинам (Вариант «В»).

Как видно из рисунка, выполненный по ЕСКД усечённый
вариант УГО «В» по высоте меньше классического примерно
в три раза и при этом содержит всю необходимую информа!
цию. Таблица упаковки Pins View для варианта «В» имеет вид
(см. Таблицу 1).

Рис. 1

PPiinn  DDeess GGaattee  ## SSyymm  PPiinn  ## PPiinn  NNaammee GGaattee  EEqq PPiinn  EEqq EElleecc..  TTyyppee
1 1 Unknown
2 2 PWR A16 Power
3 3 PWR A15 Power
4 4 PWR A12 Power
5 5 PWR A7 Power
6 6 PWR A6 Power
7 7 PWR A5 Power
8 8 PWR A4 Power
9 9 PWR A3 Power

10 10 PWR A2 Power
11 11 PWR A1 Power
12 12 PWR A0 Power
13 13 PWR D0 Power
14 14 PWR D1 Power
15 15 PWR D2 Power
16 16 PWR GND Power
17 17 PWR D3 Power
18 18 PWR D4 Power
19 19 PWR D5 Power
20 20 PWR D6 Power
21 21 PWR D7 Power
22 22 1 2 CE 1 Input
23 23 PWR A10 Power
24 24 1 3 OE 1 Input
25 25 PWR A11 Power
26 26 PWR A9 Power
27 27 PWR A8 Power
28 28 PWR A13 Power
29 29 PWR A14 Power
30 30 Unknown
31 31 1 1 WE 1 Input
32 32 PWR VCC Power

Таблица 1.
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Отметим, что если 17!разрядная адресная шина блока па!
мяти обвязывает выводы микросхем А0…А16 в одноимённые
общие цепи, то 24!разрядная шина данных таких связей не

имеет. Казалось бы поэтому, что
вариант с использованием усе!
чённого варианта УГО «В» в слу!
чае наличия в проекте несколь!
ких однотипных микросхем не!
возможен, т.к. будет ложное
объединение цепей D00…D07 и
что выход либо в создании од!
нотипных компонентов с разны!
ми названиями выводов шины
D, либо в использовании УГО
усечённого по варианту «А», ли!
бо в использовании классичес!
кого УГО. На самом деле это не
так, могут быть использованы
все три типа.

Рассмотрим для начала бо!
лее простой вариант, когда ис!
пользуется усечённый вариант
«А». Схема узла блока памяти бу!
дет выглядеть следующим обра!
зом (Рис.3):

Цепи шины данных
D00…D17 маркируются вруч!
ную (Place Port \ Net Name). Це!
пи адресов А0…А16 заносятся
туда P!CAD!ом автоматически,
как цепи PWR. Реально эти сое!
динения появляются в проекте
вместе с микросхемами памяти.
Остаётся только подключить их
к контактам Р25…Р41 и адрес!
ная шина готова полностью.

Далее все действия над про!
ектом в P!CAD Schematic ничем
не отличаются от привычных.
Полученный pcb!файл проекта,
после загрузки в него net!листа
сгенерированного в Schematic,
также ничем не отличается от
содержащего классические
компоненты (Рис.4). Известны!
ми способами производится
размещение элементов и затем
трассировка.

В случае использования
УГО, усечённого по варианту «В»,
необходимо будет выполнить
несколько действий для разде!
ления цепей шины данных.

Изначально в принципиаль!
ной схеме с УГО варианта «В»
шины данных не подключены
к контактам Р1…Р24 из!за не!
соответствия имён цепей (нап!
ример D00) и имён выводов

(например D0). Эти цепи необходимо объединить командой
Edit Nets \ Rename, переименовав D0 в D00. При этом в спис!
ке Nodes отобразятся все четыре имеющихся соединения

Рис. 2

Рис. 3
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DD1!13, DD2!13, DD3!13, P1!1, два из которых (DD2!13 и DD3!
13) необходимо будет удалить командой Remove Node. Анало!
гичные операции нужно выполнить и по отношению к осталь!
ным цепям шины данных для первой микросхемы, после чего
она будет «подключена» к контактам Р1…Р8. Несмотря на то,
что цепи D0…D7 из списка Net Names исчезли, физически они

остались, в чём можно убедиться сге!
нерировав net!лист и загрузив его в
pcb!файл. Открыв вкладку Component
Pins в окне Properties для откорректи!
рованного компонента DD1 можно
убедиться и в том, что его свойства
Pin Name и Elec Type не изменились,
хотя цепей шины данных D0…D7
в схеме уже нет.

Для того, чтобы выполнить соеди!
нения между контактами и шинами
данных микросхем DD2 и DD3, необ!
ходимо восстановить присутствие
этих цепей в проекте. Сделать это
можно переименовав дважды Ref
Des «подключаемого» элемента (нап!
ример DD2 !> DD20, затем обратно
DD20 !> DD2). Убедившись, что
в списке Net Names цепи D0…D7 вос!
становились, необходимо выполнить
их аналогичное с DD1 переименова!
ние, чтобы подключить новую шину
данных D0…D7 микросхемы DD2
к контактам Р9…Р16, т.е. выполнить
следующие переименования цепей:
D0 !> D08, D1 !> D09, D2 !> D0A, D3 !
> D0B, D4 !> D0C, D5 !> D0D, D6 !>
D0E, D7 !> D0F.

Восстановив цепи D0…D7 ещё
раз, теперь уже для микросхемы DD3,
и выполнив переименование цепей
D0 !> D10, D1 !> D11, D2 !> D12, D3 !
> D13, D4 !> D14, D5 !> D15, D6 !>
D16, D7 !> D17, получим все цепи 24!
разрядной шины данных.

В результате таких несложных
операций с именами цепей мы полу!
чили полноценную принципиальную
схему узла блока памяти с минималь!
ными по габаритам УГО варианта «В»
(Рис.5) и pcb!файл ничем не отличаю!
щийся (Рис.4) от варианта «А» или
классического. ■■

Выводы по статье:
1) Свойство переноса имени вы!

вода Pin Name типа «Power» на подк!
лючённую к нему цепь может эффек!
тивно использоваться и для других
выводов компонента имеющих об!
щее функциональное значение.

2) При корректировке цепи sch!
файла приоритет вводимого вручную
имени выше, чем у вывода типа
Power, скрытого в компоненте.

3) Цепи выводов типа Power, скрытые в компоненте, загру!
жаются в проект при вызове компонента из библиотеки или
при его перенумеровании даже если они были ранее удалены
(переименованы) вручную.

Рис. 4

Рис. 5
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Ñîçäàíèå áèáëèîòåê 
êîìïîíåíòîâ ñ ïîìîùüþ
áàçû äàííûõ áèáëèîòåê
Database Library 
(Altium Designer 6)
ААллееккссеейй  ССааббуунниинн,,  ММоосскквваа      ssaabbuunniinn@@rrooddnniikk..rruu

ППррии  ррааззррааббооттккее  ппееччааттнныыхх  ппллаатт  ббооллььшшууюю  рроолльь  ииггррааюютт
ббииббллииооттееккии  ккооммппооннееннттоовв..  ННаа  ссккооллььккоо  ппооллнноо  ии  ккоорррреекктт##
нноо  ррааззррааббооттаанныы  ббииббллииооттееккии  ппррееддппрриияяттиияя,,  ннаассттооллььккоо

ббыыссттрроо  ии  ккааччеессттввеенннноо  ббууддеетт  ррааззррааббооттаанноо  ооччееррееддннооее  ууссттрроойй##
ссттввоо..  ООччеенньь  ччаассттоо  вв ппррааккттииккее  ппррооееккттиирроовваанниияя  ввссттррееччааююттссяя
ккооммппооннееннттыы,,  ккооттооррыыее  ппоо  ббооллььшшииннссттввуу  ппааррааммееттрроовв  ииддееннттииччнныы
ии  ооттллииччааююттссяя  ллиишшьь  вв ддввуухх##ттрреехх  ззннааччеенниияяхх..  ННааппррииммеерр,,  ллииннееййккаа
ооддннооттииппнныыхх  ррееззииссттоорроовв  RR11220066##{{RR}}KK##{{QQ}}%%  ––  уу ккооттооррыыхх  ооттллииччаа##
ююттссяя  ллиишшьь  ззннааччеенниияя  ссооппррооттииввллеенниияя  ((RR))  ии  ппооггрреешшннооссттии  ((QQ))..
ВВ ппррааккттииккее  ррооссссииййссккиихх  ппррееддппрриияяттиийй  ииссппооллььззууююттссяя  ррааззнныыее
ппооддххооддыы  кк ооррггааннииззааццииии  ббииббллииооттеекк  ттааккиихх  ккооммппооннееннттоовв,,  нноо
вв ббооллььшшииннссттввее  ссллууччааеевв  вв ббииббллииооттееккее  ппооппррооссттуу  ссооззддааееттссяя  ооддиинн
ккооммппооннееннтт  ии  ппррии  ууссттааннооввккее  ннаа  ссххееммуу  ккооррррееккттииррууееттссяя  ееггоо  ссоопп##
ррооттииввллееннииее,,  ппооггрреешшннооссттьь  ии,,  ппррии  ннееооббххооддииммооссттии,,  ддррууггииее  ппаарраа##
ммееттррыы,,  ввппллооттьь  ддоо  ввыыббоорраа  ддррууггооггоо  ккооррппууссаа  ии  тт..дд..  ППррии  ииссппооллььззоо##
ввааннииии  ттааккиихх  ккооммппооннееннттоовв  ррееккооммееннддууееттссяя  ииммееттьь  ббииббллииооттееккуу,,
ссооддеерржжаащщууюю  ввеессьь  рряядд  ввооззммоожжнныыхх  ннооммииннааллоовв  ссооппррооттииввллеенниийй,,
ппооггрреешшннооссттеейй,,  ккооррппууссоовв  ии  тт..дд..  ССооззддааннииее  ттааккоойй  ббииббллииооттееккии
сс ииссппооллььззооввааннииеемм  ссттааннддааррттнныыхх  ммееттооддоовв  ппррооггрраамммм  
PP::CCAADD  22000066 ии  AAllttiiuumm  DDeessiiggnneerr  66  ннее  ттаакк  уужж  ссллоожжнноо,,  нноо  ооччеенньь
ттррууддооееммккоо  ии  ммоожжеетт  ззаанняяттьь  ннее  ооддннуу  ннееддееллюю  ррааббооччееггоо  ввррееммееннии..
ВВ ддаанннноойй  ссттааттььее  ббууддеетт  ооппииссааннаа  ммееттооддииккаа  ссооззддаанниияя  ооппииссаанннноойй
ббииббллииооттееккии  вв ппррооггррааммммее  AAllttiiuumm  DDeessiiggnneerr  66 сс ииссппооллььззооввааннии##
еемм  ссооххррааннеенниияя  ббииббллииооттееккии  ккооммппооннееннттоовв  вв ввииддее  ббааззыы  ддаанннныыхх..

В качестве примера воспользуемся интегрированной биб!
лиотекой ONE.IntLib, содержащей всего лишь один компонент
R1206!1K!5%, который можно скачать с сайта www.rodnik.ru

на вкладке Обучение>Примеры. Предположим, перед разра!
ботчиком стоит задача – добавить в данную библиотеку следу!
ющие компоненты: R1206!1.4K!5%, R1206!2.2K!5%, R1206!
1K!1%, R1206!1.4K!1%, R1206!2.2K!1%. Хотя, для столь не!
большого ряда компонентов данная процедура не будет очень
предпочтительна, указанным ниже способом можно обрабо!
тать гораздо больший массив компонентов, меняя при этом
большее значение параметров.

Для создания базы данных библиотек и последующего ее
импорта в стандартную интегрированную библиотеку, выпол!
ним последовательно следующие действия:

1. Перед началом выполнения пошаговых действий созда!
дим на диске С папку c названием Database и скопируем
в нее библиотеку ONE.IntLib.

2. Запустим программу Altium Designer и создадим новый
файл базы данных библиотек *.DbLib (см. рис. 1)

3. Находясь в режиме редактирования базы данных, вы!
полним TToooollss>>IImmppoorrtt  TToooollss  IInntteeggrraatteedd  LLiibbrraarriieess. Этим действием
начальная интегрированная библиотека будет преобразована
в базу данных библиотек.

4. В появившемся окне (рис. 2) необходимо указать ссылку
на существующий файл базы данных Access, либо просто выб!
рать некоторую директорию и ввести имя файла новой базы
данных, как было сделано в данном случае.

5. После нажатия кнопки Next программа предложит ука!
зать файл для базы данных библиотек (*.DbLib), при этом если
файл с которым ведется работа в данный момент изначально
был сохранен, то его имя в данном окне будет добавлено авто!
матически.

6. На следующем шаге необходимо указать интегрирован!
ную библиотеку, которую необходимо преобразовать в базу
данных библиотек. В рассматриваемом случае это скачанная
с сайта библиотека ONE.IntLib. Для того чтобы ее добавить на!
жимаем кнопку Add и находим библиотеку в папке
C:\Database. После нажатия кнопки Next будет запущен про!
цесс импорта, в результате которого будет сформирована ба!
за данных библиотек Base.DbLib и в рабочей папке при этом

Рис. 1. Создание новой базы данных библиотек

Рис. 2. Выбор используемой базы данных
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будет сформирован файл Base.MDB, который является фай!
лом программы MicroSoft Access.

7. После создания базы данных библиотек можно присту!
пить к созданию массива компонентов непосредственно че!

рез базу данных, для чего открываем для редактирования
файл Base.MDB, который находится в папке C:\Database.

8. При запуске программы MicroSoft Access откроется окно
с содержанием базы данных, в котором необходимо выбрать
вкладку Таблицы и после этого запустить таблицу с названием
ONE (которая представляет собой библиотеку ONE)

9. В таблице ONE имеется одна строка, в которой внесена
вся информация о компоненте R1206!1K!5%. Здесь наиболее

значимыми являются следующие параметры: Part Number –
название компонента, Library Ref – ссылка на символ (УГО),
Library Path – расположение библиотеки, содержащей символ,
Footprint Ref – ссылка на посадочное место, Footprint Path –
расположение библиотеки, содержащей посадочное место.

В рассматриваемом случае символ и поса!
дочное место будет одинаковыми для всей
линейки резисторов, а параметр Part Number
– будет уникальным для каждого из них. Кро!
ме изменения имени компонента необходи!
мо будет поменять значения в столбцах Value
– номинал резистора, Perc – погрешность. 

10. Для того, чтобы создать несколько од!
нотипных компонентов в базе данных, выде!
ляем строку имеющегося в ней компонента и
вставляем несколько ее копий в последнюю
строку таблицы. При копировании строки бу!
дет выдано сообщение, предупреждающее
о дублировании компонента в библиотеке,
при этом необходимо на данном этапе изме!
нить параметр Part Number добавляемого
компонента на R1206!1.4K!5%. 

Аналогичным действием добавляем ос!
тавшиеся компоненты и исправляем для них
значения параметров Value и Perc на соотве!
тствующие. 

11. После заполнения таб!
лицы для всех указанных ре!
зисторов, сохраняем таблицу
в базе данных и закрываем
программу Microsoft Access.

12. Теперь необходимо об!
новить базу данных, подклю!
ченную в Altium Designer. Для
этого возвращаемся в редак!
тор базы данных библиотек и
повторно подключим базу дан!
ных *.MDB следующим действи!
ем: переключим опцию Source

of connection со значения Select Database Type на Use Connection
String и обратно, после чего станет активна кнопка Reconnect.
Нажимаем кнопку RReeccoonnnneecctt, после чего в нижней части окна
в таблице появятся добавленные ранее компоненты.

13. После создания массива компонентов в базе данных
необходимо выполнить обратное действие, то есть конверти!
ровать базу данных библиотек в интегрированную библиотеку.
Прежде чем к этому приступить необходимо сохранить файл
*.DbLib, выполнив File>Save As. 

Рис. 3. Выбор файла базы данных библиотек

Рис. 4. Библиотека, открытая в виде базы данных для редактирования
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14. Для конвертации базы данных в интегрированную биб!
лиотеку нужно выполнить Tools>Offline Integrated Library
Maker. При этом запускается помощник конвертирования биб!
лиотек. После нажатия кнопки Next предлагается указать базу
данных библиотек для конвертирования, причем в строке вы!
бора уже указана база данных, с которой ведется работа. На
следующем шаге предлагается указать директорию для сохра!
нения интегрированной библиотеки и выбрать таблицу для
импорта. В нашем случае для сохранения указываем папку
c:\Database, а таблица в данной базе всего одна, под назва!
нием ONE. После этого запускается процесс конвертирования
библиотеки, в результате которого интегрированная библио!
тека автоматически открывается в панели Projects.

15. Для того чтобы удостовериться в корректности создан!
ной библиотеки, выполняем двойной щелчок на библиотеке
символов ONE.SCHLIB и после ее запуска открываем панель
SCH Library – в списке компонентов которой будет перечень
имеющихся в библиотеке компонентов. 

На примере данной статьи была рассмотрена возможность
конвертирования интегрированной библиотеки в базу данных
библиотек и показан пример использования данной возмож!
ности. Практическое применение библиотечной базы данных
может быть абсолютно разным, во!первых, база данных упо!
рядочивает структуру ссылок на набор атрибутов и моделей
каждого компонента библиотеки, во!вторых, упрощает работу
с библиотеками (подключение, поиск компонентов), и в!треть!
их, дает предпосылки к реализации совместной работы от еди!
ной библиотечной базы данных со строгим контролем исполь!
зуемых компонентов. Кроме перечисленных особенностей,
каждый пользователь сможет найти некоторые дополнитель!
ные преимущества использования БД, иными словами, появ!
ляется дополнительная гибкость в работе с библиотеками
компонентов. ■■

Рис. 5. Результат заполнения таблицы для группы резисторов

Íîâîñòè

В конце 2007 года вышло восьмое обновление системы
автоматизированного проектирования Altium Designer.
В новую версию было добавлено свыше 300 дополне!
ний и исправлений. Основными нововведениями в сис!
теме стали:

3D визуализация — теперь во время проектирования
на экране отображается не только основной вид платы,
но и ее трехмерное изображение, а также два разреза
в ранее заданных местах платы;

Инструмент выравнивания длины дифференциальной
пары — упрощает процесс разработки устройств с диф!
ференциальными сигналами и позволяет проектиро!
вать платы с использованием самых современных  тех!
нологий;

Система OpenBus — поддержка функции drag!and!drop
для определения архитектуры ПЛИС на более высоком
уровне абстракции, что позволяет значительно упрос!
тить работу инженерам по системотехнике и програм!
мистам;

Аппаратная компиляция — дает возможность разраба!
тывать аппаратные средства и увеличить аппаратное
ускорение встраиваемых приложений;

Сигнальные жгуты — соединение цепей, шин и сигналь!
ных жгутов на уровне схемы кардинально упрощено пу!
тем логического группирования всех сигналов по типу.

За дополнительной информацией обращайтесь в офис
компании ЗЗААОО  ««ННПППП  ««РРООДДННИИКК»» по телефону:
88  ((449999))  661133!!7700!!0011 и электронной почте iinnffoo@@rrooddnniikk..rruu.
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СС..  ББааннккоовв,,  АА..  ДДааввыыддоовв,,  АА..  ККуурруушшиинн,,  ММоосскквваа
kkuurruusshhiinn@@rrooddnniikk..rruu

ППррееддллааггааееттссяя  ммееттооддииккаа  ссттррооггооггоо  ээллееккттррооддииннааммииччеессккоо##
ггоо  ммооддееллиирроовваанниияя  ссооввррееммеенннныыхх  ммннооггооээллееммееннттнныыхх
ааннттеенннн  сс ииссппооллььззооввааннииеемм  ккооммммееррччеессккиихх  ппррооггрраамммм

HHFFSSSS,,  CCSSTT  MMWWSS,,  MMWWOO

В настоящее время широкое распространение для проек!
тирования антенн и других СВЧ устройств получили системы
компьютерного электродинамического моделирования, такие
как HFSS [1], Microwave Office [2], Microwave Studio [3] и др.
Применение численных методов решения задач электродина!
мики, являющихся основой указанных систем, существенно
расширило круг решаемых инженерных задач. В настоящее
время имеется возможность анализировать с их помощью
весьма сложные электродинамические устройства – напри!
мер, антенные системы вместе со схемой питания. 

Может показаться, что использование мощных програм!
мных пакетов позволяет пользователю не думать о сложных
законах дифракции электромагнитных волн и теории цепей
СВЧ, поскольку эти законы заложены в программы систем
проектирования и, возможно, что до известной степени это
верно. Однако применение численных систем моделирования
порождает новые проблемы, требующие корректного реше!
ния, чтобы не свести на нет преимущества этих систем. Насто!
ящая работа посвящена одной из таких проблем, которая воз!
никает при моделировании и проектировании многоэлемент!
ных антенн.

Будем называть многоэлементной антенной систему, сос!
тоящую из нескольких излучателей, которые будем называть
элементарными. Эти излучатели могут быть соединены со схе!
мой питания, которая формирует на входах элементарных из!
лучателей возбуждающие напряжения с требуемыми амплиту!
дами и фазами. 

Электродинамический анализ такой антенной системы,
как единого целого, требует больших затрат компьютерных ре!
сурсов. Прямое решение задачи анализа для нее с помощью
таких программ, как HFSS, может потребовать порядка нес!
кольких суток времени. Поскольку для оптимизации конструк!
ции антенной системы требуется совершить большое число
шагов, на каждом из которых решаются задачи анализа, такой
путь часто неприемлем. Поэтому разумным приемом является
декомпозиция устройства на отдельные части и анализ каж!
дой из них адекватными программными средствами. 

В случае многоэлементной антенны ее естественно разде!
лить на схему питания и излучающую систему. Каждая из таких
составных частей может рассматриваться как СВЧ многопо!
люсник, к матрице рассеяния которого предъявляются свои
требования. Одним из таких требований является согласова!
ние входов многополюсника. Например, необходимо обеспе!
чить согласование всех входов излучающей системы с выхо!
дами схемы питания. Ситуация усложняется тем, что разные
входы не развязаны друг с другом и питающие напряжения по!
даются на все входы одновременно. 

Компьютерная модель позволяет определить все парамет!
ры матрицы рассеяния такого многополюсника, однако фор!
мулировка целевой функции, выражающей требование согла!
сования, является задачей пользователя компьютерной прог!
раммы. Одна из целей работы состоит в корректной формули!
ровке условий согласования, которую можно использовать
для оптимизации, в частности, в системе HFSS. 

Следующая особенность проектирования многоэлемент!
ных антенн состоит в том, что те или иные части антенной сис!
темы удобно проектировать в различных системах проектиро!
вания. Например, время моделирования системы питания в
Microwave Office значительно меньше, чем в HFSS. В то же
время излучающую систему удобно моделировать с помощью
других систем. Использование различных программных
средств порождает проблему объединения их результатов для
расчета параметров всего устройства в целом. Далее будет
рассмотрено, как эта задача может быть решена с помощью
аппарата матриц рассеяния. 

В работе приводятся общие соотношения для расчета ряда
параметров многоэлементных антенн. Рассмотрен пример
проектирования квадрифилярной антенны с полосковой схе!
мой питания с использованием трех разных систем электроди!
намического моделирования: HFSS, Microwave Office, ЭДЕМ [4].

1. РАСЧЕТ МНОГОЭЛЕМЕНТНЫХ АНТЕНН
ССооггллаассооввааннииее  ммннооггооээллееммееннттнныыхх  ааннттеенннн  
ббеезз  ууччееттаа  ввллиияянниияя  ссххееммыы  ппииттаанниияя

В этом разделе будут приведены соотношения для расчета
входного сопротивления многоэлементной антенны при од!
новременном возбуждении нескольких ее входов для случая,
когда взаимодействием элементарных излучателей через схе!
му питания можно пренебречь.

Рис. 1. Четырехэлементная антенна со схемой питания
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Использование такой упрощенной модели является естест!
венным этапом проектирования сложного устройства и может
оказаться полезной при решении практических задач, позво!
ляя существенно снизить время решения.

Многоэлементную антенну можно рассматривать как мно!
гополюсник с N входами (рис. 1). Входы такого многополюсни!
ка не являются развязанными из!за взаимодействия элемен!
тов антенны через свободное пространство.

Решение поставленной выше задачи можно найти, исполь!
зуя определение матрицы рассеяния:

, (1)

где и вектора отраженных от входов многополюс!
ника и падающих волн (рис. 2).

Перепишем соотношение (1) в развернутой форме:

, (2)

где n=1,2,...N, m=1,2,...N.

Введем коэффициент отражения от входа антенны при
возбуждении всех ее входов одновременно:

, (3)

где вычисляется по формуле (2), и обозначим

, (4)

Тогда, подставляя (2) в (3), с учетом (4) получаем:

, (5)

Формула (5) определяет коэффициент отражения от входа
многоэлементной антенны в общем случае возбуждения всех
ее входов. Символ R выбран в отличие от принятой в литера!
туре обозначения Г – коэффициента отражения, не зависяще!
го от возбуждения входов.

Можно получить выражения для входных сопротивлений
многоэлементной антенны Zвх.п.. Используя известное соотно!
шение, связывающее коэффициент отражения в линии пере!
дачи со входным сопротивлением нагрузки, находим:

, (6)

где Z 0 – характеристическое сопротивление линии передачи.

Отметим следующие важные обстоятельства. При отсут!
ствии взаимодействия входов антенны через свободное
пространство, все элементы матрицы рассеяния, кроме коэф!
фициентов отражения Sn,n, равны нулю. Как следует из (5),
в этом случае коэффициенты отражения не зависят от соотно!
шения между амплитудами падающих волн и равны диаго!
нальным элементам матрицы рассеяния:

.

Таким образом, полученные выше формулы необходимо
применять только тогда, когда эффекты взаимной связи эле!
ментов сложной антенны становятся существенными.

Обращает на себя внимание, что входные сопротивления
со стороны отдельных входов антенны могут быть различными
даже при одинаковых Sn,n. Это имеет место, когда амплитуды
падающих волн не равны друг другу.

При проектировании многоэлементных антенн с помощью
систем численного моделирования следует обращать внима!
ние на то, что при сходстве обозначений физический смысл их
может различаться. Например, HFSS рассчитывает матрицу
рассеяния анализируемого устройства и, таким образом, па!
раметры Sn,m доступны пользователю. Эта программа рассчи!
тывает также входные сопротивления, причем для их расчета
используются коэффициенты отражения Sn,n, а не Rn, опреде!
ляемые соотношением (5). Поэтому результаты расчета HFSS
должны быть скорректированы в соответствии с полученными
выше результатами.

2. РАСЧЕТ МНОГОЭЛЕМЕТНЫХ АНТЕНН
С УЧЕТОМ СХЕМЫ ПИТАНИЯ
Эквивалентная схема многоэлементной антенны со схе!

мой питания показана на рис. 3. Многополюсник S1 моделиру!
ет схему питания. Пусть многополюсники S1 и S2 соединяются
в плоскостях b и b'. Плоскость а является входной плоскостью
всей антенны в целом, то есть вместе со схемой питания. На
рис. 3 показана схема питания, имеющая один внешний вход
с номером 0. Однако это ограничение несущественно, так как
приведенные ниже расчетные соотношения будут пригодны и
для схем питания с несколькими входами.

Анализ схемы, показанной на рис. 3, удобно проводить, ис!
пользуя результаты [2]. В соответствии с этой работой предста!
вим матрицу рассеяния S1 в следующем блочном виде:

(7)

С учетом формулы (7) можно записать следующее соотно!
шение между амплитудами падающих отраженных волн:

(8)

где , , , – вектора падающих и отра!
женных волн от плоскостей a и b. 

Рис. 2. Эквивалентная схема многовходовой антенны
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Вектора падающих и отраженных волн от плоскости b' свя!
заны следующим образом:

. (9)

Учитывая, что отраженные в плоскости b волны и
падающие в плоскости b' волны равны:

, (10),

То, используя это, исключим из формул (8)–(10) все пере!
менные, кроме падающих и отраженных волн в сечении

a . В результате получаем выражение для матрицы 
– матрицы коэффициентов отражения от плоскости a:

, (11)

где E – единичная матрица. В предельном случае, когда
в плоскости а имеется только один вход, матрица предс!
тавляет собой одно число – коэффициент отражения от входа
антенны. 

3. ПРОЕКТИРОВАНИЕ 
КВАДРИФИЛЯРНОЙ СПИРАЛЬНОЙ 
АНТЕННЫ
Квадрифилярная спиральная антенна (КСА), показанная

на рис. 4, является четырехэлементной антенной. Каждый ее
элемент – это спиральный проводник, который возбуждается
от вывода полосковой схемы питания. В идеальном случае
схема питания создает падающие волны с одинаковой ампли!
тудой и со сдвигом фаз на 90 градусов:

, , , . (12)

Применим расчетные соотношения, полученные выше,
к решению задачи согласования КСА. С учетом (12) коэффици!
енты выражаются следующим образом:

.

Подставляя этот результат в формулу (5), записываем вы!
ражения для коэффициентов отражения от портов:

,

, (13)

КСА обладает симметрией поворота. Кроме того, это уст!
ройство взаимное, так как оно не содержит невзаимных сред,
таких как ферриты. Симметрия и взаимность антенны позво!
ляют уменьшить число элементов матрицы рассеяния с учетом
следующих соотношений:

– взаимность

– симметрия (14)

Подставляя условия (14) в (13), получаем:

, (15)

Из формулы (15) следует, что коэффициенты отражения по
входам КСА не равны диагональным элементам матрицы рас!
сеяния, однако они одинаковы, что позволяет согласовывать
любой из четырех входов КСА. Другие три входа будут согласо!
ваны автоматически.

4. ПРОЕКТИРОВАНИЕ КСА 
ЧИСЛЕННЫМИ МЕТОДАМИ
Численный анализ СВЧ устройств основан на применении

электродинамических методов, используемых в различных
коммерческих программах: метод конечных элементов
(HFSS), метод моментов (Momenum, MWO EMsight), метод ин!
тегральных уравнений (FEKO, EDEM), метод FDTD (CST).

Рис. 3. Объединение многопортовой антенны со схемой
питания

Рис. 4. Конструкция KCA, состоящая из 4:х вибраторов,
питаемых со стороны 4:х портов
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Рассмотрим далее особенности проектирования КСА пока
без учета схемы питания в системе HFSS. Первый этап проек!
тирования в HFSS – черчение антенны и разбиение модели на
ячейки. 

Моделируемая КСА показана на рис. 4. Она состоит из ди!
электрического цилиндра, служащего конструктивной осно!
вой антенны, четырех спиральных вибраторов, соединенных
друг с другом крестообразными проводниками на верхнем и
нижнем основаниях цилиндра. В нижней части спиральных
вибраторов расположены четыре сосредоточенных порта.

Чтобы начертить квадрифилярную антенну, используется
операция черчения спирали DDrraaww  !!>>  HHeelliixx. По умолчанию эта
команда в меню неактивна и становится активной только если
активизирован одномерный или двумерный объект (профиль
квадрифилярной антенны). Если мы хотим создать трехмерную
спираль, заполненную материалом,  то нужно задать сечения
профиля спирали в виде двумерного объекта. Отметим здесь
трудности, которые свойственны программам электродинами!
ческого моделирования искривленных объектов. При разбие!
нии на ячейки возможно пересечение ребер искривленных
соприкасающихся объектов. Это может привести к значитель!
ному увеличению количества ячеек. 

После черчения вибраторов и линий, связывающих всю
конструкцию антенны, ее необходимо охватить боксом, на по!
верхностях которого установлены граничные условия излуче!
ния. Решение электродинамической задачи по определению
поля в каждой точке внутри бокса, дает возможность рассчи!
тать соотношения между падающими и отраженными волнами
в сечениях дискретных портов и найти параметры S11, S12, и
т.д. Пример рассчитанного коэффициента отражения S11 по!
казан на рис. 5. Приведенная характеристика соответствует
КСА с воздушным заполнением. 

Выведем на график (рис. 6) реальные и мнимые части
входного импеданса антенны.

Расчет КСА в системе HFSS является достаточно трудоемкой
задачей, требующей несколько часов компьютерного времени.
Поэтому в качестве альтернативного средства моделирования
нами была рассмотрена система ЕDЕМ [5], использующая метод

моментов. Расчет КСА в этой системе занимает существенно
меньшее время (несколько минут). Однако ЕDЕМ не позволяет
анализировать конструкции, содержащие диэлектрические те!
ла. Поэтому представляет интерес сравнение результатов рас!
четов, полученных с помощью двух разных систем.

На рис. 7 показаны зависимости действительной и мнимой
частей входного импеданса КСА от частоты. Отметим, что
в обоих представленных случаях речь идет об импедансе, по!
лученном без учета взаимной связи вибраторов КСА. 

Сравнение рис. 6 и рис. 7 показывает, что расчеты дали
очень близкие результаты. Близость результатов, полученных
совершенно разными методами, служит доказательством, по
крайней мере косвенным, достоверности решения. 

Следующий этап проектирования КСА – учет взаимного
влияния элементов антенны. Этот этап был выполнен с по!
мощью соотношения (15), полученного выше.  На рис. 8 пока!
заны частотные зависимости коэффициента отражения КСА
с учетом и без учета взаимодействия ее элементов через сво!
бодное пространство.

Из рис. 8 видно, что учет взаимной связи привел к сдвигу
резонансной частоты КСА примерно на 50 МГц, что является
заметной величиной для антенн этого класса. Уровень коэф!
фициента отражения на центральной частоте остался практи!
чески неизменным. 

Рис. 5. Частотная характеристика квадрифилярной
антенны 

Рис. 6. Входной импеданс КСА, рассчитанный на HFSS

Рис. 7. Входной импеданс квадрифилярной антенны,
рассчитанный на EDEM
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На рис. 9 представлена диаграмма направленности КСА.
Из рис. 9 видно, что несмотря на сравнительно небольшие
электрические размеры КСА обладает направленностью.
В верхнее полупространство она излучает значительно интен!
сивнее, чем в нижнее. Говоря о параметрах КСА, следует так!
же отметить ее поляризационные характеристики. Коэффици!
ент эллиптичности КСА близок к единице в верхнем полупрост!
ранстве. Таким образом антенна излучает волны с поляриза!
цией близкой к круговой.

5. ПРОЕКТИРОВАНИЕ СПИРАЛЬНОЙ 
АНТЕННЫ С ПОЛОСКОВОЙ СХЕМОЙ 
ПИТАНИЯ В СИСТЕМАХ MICROWAVE
OFFICE И HFSS
Программа MWO использует два метода для расчета СВЧ

устройств: метод Олинера, который дает аналитические выра!
жения для матриц рассеяния неоднородностей тракта, и метод
моментов, реализующий электродинамический анализ полос!
ковой схемы. 

Мы использовали программу EMSight, реализующую в сис!
теме MWO метод моментов. Структура полосковой схемы пита!
ния, начерченной в MWO, показана на рис. 10 a. 

Наряду с MWO для расчета схемы питания КСА мы также
использовали HFSS. Структура, рассчитываемая методом ко!
нечных элементов в HFSS, показана на рис. 10 b. Использова!
ние разных программ для решения одной и той же задачи поз!
воляет контролировать достоверность решения. При этом сле!
дует отметить существенно большее быстродействие MWO по
сравнению с HFSS.

Из рис. 11 видно, что в силу жестких требований к габари!
там антенны элементы полосковой схемы расположены весь!
ма близко друг к другу. Поэтому их взаимное влияние через
реактивные поля и поля излучения становится весьма сущест!
венным. В этом случае декомпозиция устройства на элемен!
тарные полосковые неоднородности, являющаяся основой
метода Олинера, не может корректно описать сложную карти!

Рис. 8. Зависимости коэффициента отражения S11 без учета
взаимной связи и с учетом ее

Рис. 9. Диаграмма направленности квадрифилярной
антенны

Рис. 10 a. Схема питания в MWO

Рис. 10 b. Схема питания в HFSS

Рис. 11. Подключение квадрифилярной антенны 
к сумматору
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ну взаимодействия электромагнитных волн в такой
структуре. Это определило выбор электродинами!
ческих методов в качестве основных для проекти!
рования схемы питания КСА.

Основная задача схемы питания КСА – равное
деление по мощности и создание разности фаз в 90
градусов в диапазоне частот. Качество решения
этой задачи в системе MWO можно оценить из
рис. 12,13, на которых представлены частотные за!
висимости модулей и фаз коэффициентов передачи
с центрального входа схемы питания на входы, сое!
диненные с портами КСА.

Возможности MWO позволяют эффективно оп!
тимизировать конструкцию делителя мощности и
получить равноамплитудное деление мощности на
входах схемы питания.

Программа трехмерного моделирования также
позволяет оптимизировать устройство по заданно!
му критерию качества. В качестве целевой функции
можно задать отличие разностей фаз на выходах
схемы питания от требуемых значений 0°, 90°,
180°, 270°. В результате оптимизации получаем
близкие зависимости амплитудных и фазовых ха!
рактеристик, полученных на MWO и HFSS. 

Рис. 12. Фазо:частотные характеристики элементов матрицы рассеяния
схемы питания КСА

Рис. 13. Амплитудно:частотные характеристики элементов матрицы
рассеяния схемы питания КСА

Рис. 14. Фазо:частотные характеристики элементов матрицы рассеяния
схемы питания КСА, полученные на HFSS

Рис. 15. Экспериментальная зависимость КСВ
КСА от частоты

Рис. 16. КСВ квадрифилярной антенны
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На рис. 14 показаны фазо!частотные зависимости коэф!
фициентов передачи схемы питания, полученные с помощью
HFSS. Они весьма близки к зависимостям на рис. 12.

Задачу моделирования КСА вместе со схемой питания сти!
мулировали экспериментальные исследования макета КСА.
Измеренная зависимость коэффициента стоячей волны (КСВ)
от частоты показана на рис. 15. Оказалось, что данные расче!
тов заметно отличаются от экспериментальных данных. В пер!
вую очередь это относится к ширине полосы КСА, которая оп!
ределяется по заданному уровню КСВ. Интересно, что экспе!
риментальная полоса рабочих частот оказалась почти в полто!
ра раза шире расчетной. Для выяснения причин этого расхож!
дения была построена полная модель КСА, объединяющая
данные EDEM (HFSS) по расчету собственно КСА и данные
MWO по расчету схемы питания. В основе этой модели лежит
соотношение (11). 

Заключение
Ужесточение требований к характеристикам современ!

ных излучающих систем приводит к усложнению их конструк!
ций. Такие сложные антенны имеют один вход, но могут иметь
большое количество излучающих элементов. Одной из наибо!
лее распространенных таких конструкций можно считать ре!
гулярную антенную решетку. Решение задачи поля для того,
чтобы получить характеристики антенны в дальнем поле,
а также частотные зависимости входного импеданса – в рам!
ках проектирования, решаются на современных коммерчес!
ких программах. При решении поставленной задачи  было
выявлено, что:

• современные программы позволяют эффективно рас!
считывать многопортовые антенны с различными сигналами
на входах;

• из!за взаимного влияния отдельных излучателей (объяс!
няемой  близостью линий, синхронностью текущих токов) усло!
вия согласования и характеристики многопортовых антенн;

• в результате, в многопортовых антеннах выявлена зави!
симость линейных параметров антенны параметров от мощ!
ностей, подаваемых на отдельные входы, что делает ее похо!
жей на параметрические цепи.

Формулы, приведенные в работе, чрезвычайно важны при
проектировании многопортовых антенн. Приведенные резуль!
таты показывают, что при учете влияния всех портов на конеч!
ные разультаты, резонансная частота квадрифилярной антен!
ны изменяется на 20–30 МГц и приближается к эксперимен!
тальным данным. ■■

Литература
1. Разевиг В.Д., Потапов Ю.В., Курушин А.А.  Проектирова!

ние СВЧ устройств с помощью Microwave Office. Под ред.
В.Д. Разевига, М., СOЛОН!Пресс, 2003, 496 стр (Серия «Систе!
мы проектирования»), 496 с.

2. 1. Д.М. Сазонов, А.Н. Гридин, Б.А. Мишустин. Устройства
СВЧ. М.,  «Высшая школа», 1981, 295 с.

3. Банков С.Е., Курушин А.А. Разевиг В.Д. Анализ и оптими!
зация трехмерных СВЧ структур с помощью HFSS. Под ред.
д.т.н., проф. Банкова С.Е. М., СОЛОН!Пресс, 2004, 208 с. 

4. http://www.cst.de/
5. http://www.edem3d.ru

Íîâîñòè
НАСА выбирает Altium Designer!

Система проектирования электронных устройств AAllttiiuumm
DDeessiiggnneerr компании AAllttiiuumm  LLiimmiitteedd выбрана Космичес!
ким центром Джонсона (Johnson Space Center) Нацио!
нального агентства по аэронавтике и исследованию
космического пространства США (NASA) в качестве кор!
поративного стандарта программного обеспечения для
разработки проектов электронных устройств. Данная
система будет использоваться в Космическом центре
Джонсона для моделирования, анализа целостности
сигналов, разработки печатных плат и ПЛИС, а также
для других задач, которые будут выполняться на основе
единой платформы Altium Designer. В дальнейшем Кос!
мический центр Джонсона планирует перевести все су!
ществующие проекты в формат Altium Designer.

Руководитель департамента проектирования и разра!
ботки электроники НАСА, Мэтт Лемке (Matt Lemke), от!
метил: «После оценки всех имеющихся на современном
рынке систем автоматизированного проектирования
мы сделали выбор в пользу инструментальных средств
компании Altium Limited, и надеемся с помощью данно!
го продукта существенно сократить сроки разработки
изделий». 

Главную роль в выборе НАСА сыграли высокие требова!
ния к разработке космических систем, основным из ко!
торых является системный подход к проектированию
электронных средств; а также возможность поддержки
всех существующих проектов, наличие средств для мно!
гократного внесения изменений в текущий проект, при
экономии затрат времени и ресурсов. 

Altium Designer будет использоваться в качестве плат!
формы для разработки электроники в интересах как пи!
лотируемых, так и беспилотных аппаратов, в програм!
мах Space Shuttle, International Space Station, а также
в новой программе для полетов космонавтов на Луну. 

Систему Altium Designer планируется применять при
разработке систем управления и навигации, энергосис!
тем, систем авиационной радиоэлектроники, контроль!
но!измерительной аппаратуры, систем тепловой защи!
ты, космических скафандров, оборудования для работы
за бортом корабля и многих других устройств, при раз!
работке которых необходимо применение передовых
технологий в области автоматизированного проектиро!
вания. 

«В настоящее время центр Джонсона осуществляет наи!
более перспективные программы космических иссле!
дований, и мы рады, что НАСА выбрало Altium Designer
для совместных работ», – заявил Ник Мартин (Nick
Martin), основатель и генеральный директор компании
Altium Limited. Он также добавил, что компания предла!
гает инженерам всего мира продукт с унифицирован!
ной средой разработки электроники, превосходящий
современные аналогичные средства. 
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